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User Interface

In this chapter we are going to learn all
the details of the User interface. We will
have a close look on the windows and
the dialogs as well as on the navigation
and settings throughout SCOPE.

In order to get an overview we divided
this chapter in different sections:

* Menu bar
Project Window
File Browser
Tool Bar

Project Explorer

These five windows are the main tools
in the SCOPE environment.

SCOPE provides a lot of possiblities to
work indepedent or to develop own
projects. Therefore the user is
responsible for himself in order to benefit
from the nearly boundless possibilities
the SCOPE fusion platform offers.

Menu bar

The menu bar contains four important
items:

- File iew Window

Deyit:es

On the other end of the menu bar, next
to the ‘Minimize’ and the ‘Close’ buttons
we can see a Cream Ware symbol.

You can reposition the menu bar by
pressing the left mouse button on the
CreamWare symbol and moving the
mouse to the desired screen half (upper
or lower). The menu bar will reposition
itself appropriately.

Menu Bar

/
File View
New DSP Load
Open Controller
Save Settings
Save as... Samplerate
Recent » ULLI Settings
Exit SCOPE Registry
ControlRanger
Exchanger
About

'Window | [Devices |

Project Window 1

Project Window 2

File Browser

Project Explorer

Parameters »

Tool Bar




File
The first menu on the menu bar is the
File menu.

| Open
Save
Save as ..
Recent

You can open the pull-down menu by
clicking on the name. This menu
contains the options you need to mana-
ge our projects. You can create a new
project by clicking on the ‘New’ dialog
box.

To open a project again use the ‘Open’
dialog box.

The next two items are relevant if you
want to save your project or segments
of your project. Therefore you could use
an index in the name of the project and
enlarge it for every session.

SCOPE does not use any ‘Undo’
functionality. So we advise you to save
often and to use different names for
important milestones within your
project.

In order to open the recent used projects
we can click on the ‘Recent’ dialog box
and choose the project we want to work
on.

The last dialog box ‘Exit Scope’ shuts
down the SCOPE /SDK.

View

The View menu gives you access to the
Controllers and the Settings of the SCOPE
environment.

View Window
| DSP Load |
Controller
Settings
Samplerate
ULLI Setting=s
Registry
ControlRanger
Exchanger I

About |

DSP Load: Opens or closes the DSP
utilization display which monitors current
DSP usage.

Controller: Opens or closes the Controller
Settings dialog where you can adjust the
MIDI controller assignments.

Settings: Opens or closes the SCOPE
Settings dialog in which you can set
various program options.

Samplerate: Opens or closes the Sample
Rate Settings dialog used to adjust the
Sample Rate and Word Clock settings.

ULLI Settings: Calls the dialog used to
select the Ultra Low Latency Interface
driver settings.

Registry: Opens a list of optional modules
and all keys.

Control Ranger: States the properties of
the selected control ( values margin etc.).

Exchanger: Replaces a module with
another one while maintaining the
connections.

About: Opens or closes the dialog
providing information on the program
version.
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DSP Load

Selecting DSP Load from the ViewMenu
calls the DSP meter module. This
module identifies the installed boards
(Pulsar, Pulsar SRB, SCOPE, etc) as
well as the total number of DSPs
available. The bar display indicates the
current extent of DSP utilization. The
lower part of the window shows the
usage of each DSP.

DSP Load X
total
number !
of
available
DSPs

MIDI Controller Assignment

You can open the MIDI Ctrl Assignment
dialog by clicking with the right mouse
button on the control element (fader,
knob etc.) you want to control.

Assign Reset

RN Ciel Assigniment
o wmio

Current Ny

Transfer

Step

Intensity

2147483847 |8 3 Tnvert 1
Current Value

Current: Shows the current controller
assignment.

New: The MIDI controller number is
displayed here when controller data are
sent.

Assign: Usesthe ‘ New’-value to assign
a controller number to the onscreen
control element.
Reset: Cancels
assignment.

Ctrl List: Calls the Controller Settings
dialog in which additional options are
available.

the controller



Control Ranger

This dialog is called either by choosing
Control Ranger or Controller from the
View menu, or by clicking on the Ctr/
List button in the MIDI Ctrl Assignment
dialog. To edit a control you have to
select it and change the settings in the
Control Ranger window. You can adjust
the minimum and the maximum value
with the two faders on the left side or
type the favored value directly in the text
fields.

In order to divide the range of the
selected control into different sections,
type in the amount of steps the controler
should make. (1: continously adjustable,
2. one step, 3-max.: the control moves
in the defined steps).

The curve characteristic(linear,
logarithmic, exponential, logarithmic bi-
polar, exponential bipolar) depends on
the input and output values of the
selected control.

The name of the current value is always
visible as well as the name of the control
to which the controller is assigned to.

In order to get the other options available
you have to click on the drawer at the
bottom of the window to openiit.
Channel: Displays and adjusts the MIDI
channel used for controllers. Learn:
Displays the controller number of any
controller data received by the device
on the controller MIDI channel.

Link Channels: Can be enabled or
disabled by clicking on the small box.
Used to link channels.

SCOPE Settings

Call this dialog by choosing Settings
from the View menu. Here you can set
various program defaults, such as the
Default and Background projects, and the
various directories in which specific
filetypes are located.

Dual Screen: Clicking on the monitor
icon switches dual monitor support on
or off. The Screen field below determines
the way the software modules are
distributed between the two monitors.

If Dual Screen mode is enabled, you
can also move the SCOPE surface to a
second monitor.

You can also adjust the size and position
of the Scope work area.To arrange the
screen contents drag the right lower
corner of the work surface
representation with the mouse. You can
also move the Scope surface directly
with the mouse. Double click on the
surface to return it to maximum
size.Changes become effective only
after you close the dialog.

Standard Cursor: This option selects
the standard mouse cursor of the
operating system in place of SCOPE’s
custom cursor. You should only enable
this if experiencing graphic anomalies
that bother you, such as a flickering of
the SCOPE mouse cursor.

Show windows while move: If this
fuction is enabled the windows become
transparent while being dragged. This
lets you see what you're about to cover
up. It can also be a quick way to see
what'’s currently hidden behind an object.



Fade windows/Create new icon on
minimize/ High quality icon:

These dialogs do not have a meaning in
SCOPE SDK, but for the sake of
compatibility we decided to leave them
in SCOPE.

Grid Horizontal/Grid Vertikal:  If you
enabled the Grid (Tool Barn)and you want
to change the adjustments of the pattern
then you can type in new values.

Project as OS Standard: Clicking on
this button sets background project to
the current project. This is the project
that establishes drivers and routings for
the operating system when the Scope
program itself is not running. This
overwrites the original file, so you should
protect it (rename it, or move a copy to
another location) before using this option.

Projectas Default: Use this option when
you want the current project to be used
as the basic default project. This is the
project that is loaded when you choose
New from the File menu.

Scope Settings T} DualSereen e

M Standard Cursol

3 Show windows while move

M Fade Windows

E3 Create new lcon on minimize li
E3 High Quallty lcons E 3

& Project as 0S Standard
Grid horizontal

o  Project as Dofault Geid vartical

File Directories

Projects
Devices
Wodules
Piesels
Akai Files

File Directories

File Directories

The fields in this drawer specify the
default paths for the various file types;
Projects, Devices, Modules, Presets
and Akai Files. Dialogs for handling these
files will open automatically to the
appropriate directory as shown here.
Change the path by overwriting the
existing text.



Sample Rate Settings

This dialog appears when you select the
corresponding entry in the View menu.
If more than one compatible board is
installed, the Sync Source part of the
dialog will change to accommodate the
available inputs provided by additional
hardware.

Sample Rate Settings el

System Slave 7
Copnected  Syne Source
Pulsar2 AESEBU Q 32kHz @
ADATA @ A44dkHz Q
ADATE @ 4ikHz @
L]
]

aster PR
Sample Rate

opt. ADAT Q SMux A 96kHz @
opt. SIP-DIF @ SMAux B

System: Displays the current system
sampling frequency.

Slave: When Slave is enabled, Scope
derives its word clock from the digital
input selected under Sync Source.
Master: When Master is enabled, Scope
uses its own word clock at the sampling
frequency adjusted under Sample Rate.

Sync Source: When Scope is in Slave
mode, it derives its word clock from the
signal at the digital input selected here.
The list of available inputs will change
to reflect the installed hardware.

If an S/IMUX signal is connected to one
of the ADAT ports in slave mode, you
must inform the software by enabling the
appropriate S/IMUX button.

Sample Rate (32/44.1/48/96 kHz):
Adjusts the sampling frequency when
Scope is functioning as word clock
master.

Connected: This LED indicates whether
or not a valid signal is available at the
corresponding input to which Scope can
be synchronized as a word clock slave.

opt ADAT/ opt S/P -DIF: If you have a
Pulsar card installed. ot a Pulsar Il or
SCOPE card with an I/O option with S/P
-Dif and ADAT (e.g. Clame, Plus,
Zlink)you may choose to use the optical
connectors as ADAT receivers (inputs)
and transmitters (outputs) and to use S/
P-Dif only at the electrical connectors
(Digital In/Out).

Alternatively you may choose to use the
optical connectors as S/P-Dif receivers
and transmitters. In that case the ADAT
A is not in use anymore, the S/P-Dif
signal output is simultaneously sent to
the optical.and the electrical transmitter
while the electrical receiver is notin use.
‘Sync to S/P-Dif ‘ now listens to the
optical output.

When using a Zlink 1/0 option, things
are a little bit different. The electrical S/
P-Dif is always in use. When switching
to ‘optical S/P-Dif’, the transmitting
device switches to S/P-Dif. The receiver
is able to detect the signal type which is
feeded to the optical inputs and sends
the signals to the appropriate I/O module.
Because you have two different s/P-Dif
inputs (electrical and optical) you can
choose to which of them you to sync (
‘Sync to S/P-Dif’ or ‘Sync to opt. S/P-
Dif).



ULLI Settings

Use this dialog to adjust the size of the
ASIO driver buffers (reserved memory
areas) and the resulting delay (latency).
The delay depends on this setting, and
the actual sample rate as represented
in the table. Smaller latency values
require greater host computer
performance. Find the best compromise
for your system by experimentation.

choose whether you want the settings to
be adjusted directly or if the settings
u should be adjusted after a restart.

I If you change the ULLI settings you can

- Ll e
_,f__,r_,——r;/

IH:If.ﬂ I.-w Lnluur l'lll-rfurl

32 Khz 44,1 Khz 48 Khz 36 Khz

Jms Ims Ims
dme  Ams  Zme
Gms  3ms

G

Registry

Call this dialog using the entry of the
same name in the View menu. This
display-only dialog indicates all the
auxiliary modules for which a key has
been registered by the system.

Module Reqistry

HW SN Key Module

000000000 7MLKINEF7ZMM - Scope Fusion Platfo
000000000 BSM7OS77TEE3  Miser Package 1
000000000 MOTADSEYREY3  Miser Fackage 2
000000000 HOBGOTTYZWER Synths Package 1
000000000 CARYDIKIEIEX  Syhths Package 2
000000000 8mMxFOLLZ<415  Effects Package 1
000000000 CZKBOFE7EMAH  E ffects Package 2
000000000 1GEKMATEIAE  Pulsar Spplication

000000000 BZEZORFFY3EH Pulsar PRO Packag
TREANTI/EEER =

000000000 [Creamware]
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Properties Module Exchanger ) (1)

Wal E @Potentiometer Turqu E @Fotentiometer Turge
[OFad
Integer Wal Wal

4 Curve Curve

0 [nterzity [rtenzity
2147483647 kir kit

e b 2

[t [t

Step Step
Dizabled Dizabled
Crlidr Ctilkdr
MadF ange ModF ange
toveStyle b oveStyle

L SR e S
PRI O SN S S

Module Exchanger

Sometimes when working on a design About:

you will decide that another module, a Opens or closes the dialog providing
different filter module for example, would information on the program version.
better serve a purpose. With the Modu-

le Exchanger you can replace the module

with another one while maintaining all e

the connections. B T b

The dialog opens automatically when you S e e s SOt
drag and drop one module onto another < e - A
in the Project window while pressing the Wt Ko T o 18 R Dl

<Alt> key. For example a potentiometer
should be exchanged in favor of a fader.
All the connections that could be
assigned are indicated with a green
check mark.

Connections that could not be assigned
are indicated in red.

If you don’t want to assign all the
connections double click on a Pad name
and it will not be connected and appear
in red lettering on both sides of the list.
To re-connect, doubleclick on an entry
again. When you are satisfied, click on
the Exchange icon.

 Contents | index | 11



Window

The Window menu provides a quick
access to the main surfaces in the
SCOPE environment.

Project Window 1/ Project Window 2:
Opens or closes the Project Windows.
File Browser:

Opens or closes the File Browser.
Project Explorer. Opens or closes the
Project Explorer.

|

[Window
ProjectWindow 1

| Projectwindow 2 I

FileBrowser

ProjectExplorer

Parameters »

Toolbar

Hew Dialogs b
Alignment
Bitmap/Animations

Blit Algorithm

Color

Dimensions

Dyniamic

FillStyle

Gradient

Shadow

Text

Texture

Transfer Options |
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Parameters

Module Parameters: This dialog shows
a list of parameters of the selected
module. It represents the module name,
the paramter name and the parameter
settings and attributes.

Parameters ModuleParameters
Toolbar ModuleParameterTree
Hew Dialogs PresetParameters
Alignment ParameterRanger

NModileParameters
(Ranger [Dump | Freeze |

Modde  Neme P RPRSRPRRSF 55 SP SR Defauk Vel

Frezetl izt cwlaztAestoredFreszet
Prezetlist Sizetr

Frezetlist Sizer

Prezetlist FosgY

Frezetlizt Fog

Frezetlist FresetFie2

Frezetlizt FrezetFie

FarentT opChanger Top

Compressor . Fogy

Compressor k. Foss

SOL200

Mot

Compressor .
Surfacelnterface
Signalswitch

[f

SDL200
Compressor aL2
Compreszar AL2
Compressor &L2
Compressor aL2
SDL200

Compressaor

Clut

Side Chain Mode
K.atrin
Open PLizt
Brpaszz

L& Mode
L,

Gain

Hatio
Threz

Rel

Ot

oM oM oM oM MMM

Mo o M oMM oM M MM

Mo o o oM MM MM MM

=

M om o oM oM M oM M MM

Mo oM M oM MM

Mo oM M oM MMM

M om o oM oM OM M MMM
oM oM M oM M X

Mo oM M oM oMM M
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Module Parameter Tree: In this dialog
you can generate parameters and put
them in your favorite order. To generate
a parameter you can drag and drop a
Pad from the Pad Listin the Parameter
Tree.

Parameteriree

Freeze
& Compressor M
i At
Thres
@ Ratio
B Gan

| LA

B LA Mode

M n

B Margin

Mat In Preset
| Out

Compressor hd

Preset Parameters: List of parameters
of the selected module which can be
restored in a preset.

PresetParameters

1 out
2 Side Chain Mode
3 owlastRestoredPreset

FresetList in Compreszar b

Parameter Ranger: With the Parameter
Ranger you can adjust the default value
setting of the parameter.

= .

[ 2147433543
——————g | : 100

(o g [

gl

jic:wLas*tRes’mredPreset | Shorinaine

alue | ~ ]

Tool Bar: Opens and closes the Tool
Bar. The options you have in the tool bar
are also available through the Window
menu. A detailed description of these
tools will be given in the Tool Bar chapter.
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Devices

Provides minimized thumbnail views of
the loaded devices and modules. This
allows you to open a device or module
even when the Project Window s closed.

[Devices

Clicking with the left mouse button on a
thumbnail opens the respective control
surface, or puts it on top if it is open but
covered by other surfaces. Clicking with
the right mouse button closes the
surface. If you hold the CTRL key while
opening a device, all other device
surfaces will be closed.

Doubleclicking with the left mouse button
right beneath the device icon opens or
closes the device's Preset list
respectively.

If the device is a synthesizer, the current
polyphony setting is displayed below the
thumbnail. This setting can likewise be
altered by entering a new value.

The current MIDI channel is indicated
to the right of the Preset list symbol. To
assign the MIDI channel, click on the
current value and type in a new one from
the computer keyboard. Then press
Enter to confirm the change. You can
change the order of the device icons of
the devices menu by simply dragging the
icons to the desired position.

15



Project Window

Project Window

Work modes

[ use |
[ Ear ]

|Command Bar

Views

[ circuit |

Move out

This is the primary SCOPE construction
area. The components of a project — the
individual devices and modules — appear
in this window when a project is loaded.
Connections can be added and removed
here, and creation and modification of
modules and devices — on both the circuit
and graphical levels —is also carried out
primarily via this window. The name of
the current project file appears in the top
edge of the Project Window frame.

If we have a look at the Project Window
we can distinguish between five sections.
The Work modes are situated on top of
the Window, as well as the command
bar and the Views. Our actual work
space where we arrange our circuits
takes the largest part of the window.

On the bottom of the window stands the
location line .

Hew Project

In this chapter we will have a look on
these different sections of the Project
Window.

16



Work modes

The work modes — one of the three is
always in effect - determine the behavior
of objects. You'll need to know how to
use these buttons and modes as soon
as you begin working in the Project
Window.

Note that each one has an associated
I keyboard shortcut.

Use Mode (Ctrl-U)

The default «use» mode. Modules and
devices can be added and deleted via
the Project Window, and connections
between them can be modified, but they
cannot be repositioned within the
window. Faders, buttons and other
graphical controls can be operated using
the mouse, but graphical elements
(controls, displays, labels etc.) cannot
be repositioned on the surfaces they are
attached to the Project Window, if not
attached to a surface. It is not possible
to go inside a device or module.

Hew Project

Move Mode (Ctrl-M)

Modules and devices can be added and
deleted via the Project Window, and
connections between them can be
modified. Permits repositioning of
modules and “unattached” graphical
elements within the Project Window (but
not, therefore, the operation of graphical
controls), as well as entering a device
or module by double clicking on it for
leaving it and by double clicking on the
background to view and modify its
internal structure. Device surfaces can
still be operated normally, but Move
mode also permits the repositioning of
graphical elements on a device surface,
when working inside a device.

Edit Mode (Ctrl-E)

Permits direct manipulation of the
individual graphical components from
which screen objects are built. Most
Use/Move mode operations are not
possible in this mode.

Pulzar2 [0] MIDI & Source Out

Sequencer Midi Source 1 Out

Out
ROut

Pulzar2 [0] Analog Source

Pulsar2 [0] SP-DIF Source oo

LOut
ROut

Wave Source 1

Mew Project

B in Pulzar2 [0] MIDH A Dest
kIn Sequencer Midi Dest 1

; :;:Ilr;l Pulzar? [0] &nalog Dest
P Lin
pRin Pulzar2 [0] SP-DIF Dest
P Dig

pLin




Cut | Copy |Paste |Delete |Duplicate

Group |Ungroup |Fold |Unfold | Move into | Move out
—— — -

Command bar

The command bar contains the tools you
need to arrange your circuit. With the
first functions (Cut, Copy, Paste,
Delete) you can proceed in the same
way as with those functions you know
from working with you PC. For example
if you dragged in the wrong module from
the File Browseryou can just press the
Delete button and the module
disappears. For this working process you
can also press the ‘Delete’ key on your
keyboard.

If you want to clone a module you can
select it and click on the Duplicate
button on the command bar . The mouse
pointer will change into the ‘drop’ arrow
and you can position the module
anywhere in the Project Window.

Within the next functions always two
buttons belong together. In order to group
a certain number of modules you have
to select them by shift clicking one after
the other or drawing a rectangle around
them. Now you only have temporary
groups; that means that they will
disintegrate as soon as you click on
another module. So you have to click on
the Group button to create a new group.
You can still move the modules
separately but they will stay in a group
until you loose the group by clicking the
Ungroup button. If you now have a look
at the Project Explorer (for detailed
discription of the Project Explorer see
page 34) you will see, that the grouped
modules are displayed together in a new
module called ‘Group’.

With the Fold and the Unfold button you
can fold an undefined amount of modules
together to one module by selecting the
modules ( shift clicking one after another
or drawing a rectangle) and pressing the
Fold button.You will see that the modules
pool together to one module which
automatically has the important Pads on
its surface. This module is a totally new
module and is therefore named ‘folded’
in the Project Explorer. To make the
folded modules visible you have to click
on the *'sign in front of the module name.
In order to undo the Folding just elect
the Unfold button.

you can double click on the module and
you will step one layer deeper. To step out,

m Jdouble click on the background of the
Project Window.

I In order to step inside this folded module

If you want to put another module in an
existing group you can select it and put
it via the Move into button in the group.
You can also put one module into another
by clicking the Move into button.

In this way you only stick the module to
the other one instead of folding them
together and creating a new module. This
process can also be done via the Project
Explorer.You have to select the module
you want to move and drag it to the other
one with the left mouse button pressed.
With the Move out button you can undo
the connection and bring the module out
again.

18



Views

Surface elements and circuit elements
are distinguished by their ViewID.

In the upper right corner of the Project

Windowwe can see the two views: The
Circuit view and the Surface view.

Clreuit PSURace

We can toggle between the views by
pressing the buttons or using the
shortcuts F7 (Circuit view) and F8
(Surface view).

In Circuit view the circuit is displayed.
This is where you add nodes and make
connections from one module to another
to route Audio, MIDI and control streams.

In Surface view you design the user
interface for the devices. There is a
decoupling of circuits and surfaces so
that you can really concentrate on
designing the interface without having to
handle all the circuit nodes in the same
window, too.

Location line

The location line at the bottom of the
Project Window indicates which
hierarchy of the project is displayed.

Actual work space in the Project
Window

When the program starts, the Project
Window opens containing some basic
modules which are loaded by default
(you can change the default project in
the ‘'SCOPE settings’ ;see chapter File
management). These modules represent
the physical as well as the software
inputs and outputs. Input modules are
located on the left side and serve as a
data source whereas output modules are
located on the right and serve as data
destinations.

To explain this a little bit further have a
look at the following example. When you
want to route a signal from your hard
disk recording program into a SCOPE
mixer, you would first select one of the
SCOPE virtual outputs in your recording
software .

Back in the SCOPE environment, the
recording application’s output signal is
represented as a logical input, since the
signal is being led into the SCOPE
Project Window from the recording
application. We use the terms source to
represent logical inputs and dest (for
‘destination’) to represent logical outputs.
External signals always arrive into the
SCOPE environment via source
modules, and leave via dest modules.

19



Project Settings

A short description of the software
I/Os loaded by default:

Wave source/dest: These modules
correspond to the audio driver (MME,
16 bit) that appears in your audio
software as inputs and/or outputs. The-
se modules can be loaded up to 16 times,
for a total of 32 audio channels in each
direction. (For 24-bit resolution, these
modules must be replaced by the 24-bit
versions).

Sequencer Midi source/dest 1: These
modules represent the MIDI interface
into a MIDI program, such as a
sequencer. Note that you must access
the source module in your MIDI pro-
gram by selecting the Pulsar 2 output
(Pulsar 2 Midi Out) while you access
the dest module form your MIDI program
by selecting the Pulsar MIDI inputs (Pul-
sar 2 Midi In). The number added to the
name designation, such as‘l’, indicates
that this is the first of several possible
MIDI interfaces. Additional interfaces are
implemented by loading modules
repeatedly.

Asio source/dest: These modules
implement the ASIO driver that
Steinberg’s Cubase VST uses. You can
adjust the number of channels from 2 to
32 by doubleclicking on the module to
open the control surface.

Depending on your installed Creamware
Audio cards or the equipped I/O options
or expansions you will find modules
beginning with the name of your audio
card (e.g. SCOPE, Pulsar Il,...) followed
by the type of I/0O (e.g. analog, S/P-Dif,
MIDI, ADAT, Z- Link,..).

Loading modules and devices

All Modules and Devices are loaded into
a SCOPE project by dragging them with
the left mouse button from the File
Browserinto the Project Window.

You can also load a module or device by
dragging it from the Devices menu at
the top of the Project Window and
dropping it into the window.

Most of the modules and devices can
be loaded repeatedly. Exceptions to this
are, for example, modules representing
the physical 10s, and certain special
devices.

Deleting modules and devices

To delete a module from the Project
Window, first select it with a mouse click.
Then hit the <Del> key on your keyboard
to remove it and all its connections from
the project. You can also click on the
Delete button in the command bar to
remove the module or select ,Remove
module” in the context menu. Rightclick
on the module to open the context menu
(See page 18 for a detailed information
on the context mendu). If you want to delete
more then one module you can select
themby drawing a rectangle around the
modules with the left mousebutton
pressed.
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Signal flow and module

connections

A signal flow is established in the Project
Window by connecting modules together
by using SCOPE’s virtual cables. An
output from one module can be
connected to a compatible input on one
or more other modules. The virtual wires
can be distinguished by their colors:

The blue wire
symbolizes a
synchronous connection
whereas the green wire
represents an
asynchronous
connection.

The red wire Is a
symbol for a MIDI
connection.

In order to visualize the different steps
of a connection the Scope cursor takes
different shapes.

The different looks of the curser
in SCOPE

Before continuing with the description
of the Project Window we should have a
look at the different cursors which
appear in the Project Window.To
establish a connection first click on the
output, and then on the desired input
(although the reverse sequence is
possible). The connection is then
represented by a cable that appears
between the modules:

While the mouse cursor is over a
connection, its shape can take one of
the following forms:

normal: ‘Q,

&

Set connection by clicking:  «

One side has been connected: "

Connection not possible: a.’."f

Connection is separated: \o

When you place the mouse over a
connection the first time, the symbol

changes from standard % toa patch

cord plug h# . When you click, the

el

symbol changes back to «* (or

possibly the ‘Connection not possible’
symbol, if the connection is occupied).
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If you now move the mouse pointer, the
cursor changes to & (to signify you

are holding the other end of the cable in
your hand). When the pointer is placed
over another compatible connection, the
cursor changes again to a plug

&

symbol «+ =" .

Now, when you click, the connection will
be established, the cable will appear, and
the mouse cursor will resume its
standard form.

If you want to establish connections
between the other inputs and outputs of
the same modules and devices you can
use the key ‘N’ on your keyboard. This might

m come in handy when connecting stereo
devices or even larger ones. You have to
note that this function only works on one
side of a module, that means that you can
not press ‘N’in order to connect other Pads
which are positioned on an other side of
the module or device.

Deleting Connections

To delete a connection, simply select the
cable by clicking on it, and then strike
the <Del> (or <Delete>) key on your
computer keyboard. If you want, you can
also click again on both ends of the
connection, which also deletes it. In this
case, when the mouse is over the first
connection point, it changes to a plug

&

symbol, =« , and over the second, to

a scissors symbol Y
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Control elements

Modules and devices implement control
surfaces whereby individual parameters
can be adjusted.

A control surface can be opened by:

- using the Surfaces command from the
context menu which appears when you
right click on a module or device
representation in the Project Window.
(More detailed information about the
context menu in the next chapter)

- clicking on the device icon in the
Devices menu

Although the controls and switches used
by the device surfaces may look diffe-

rent, their operation is consistent and
falls into general categories.

Potentiometer

Sine Osc

e

Rotary Contols (potentiometers) can
be adjusted using the mouse. Click on
the control with the left mouse button,
and move the mouse cursor around the
control in a circular fashion. The control
will follow. In order to make very fine
adjustments, increase the radius of the
circle (move the mouse further away
fromthe center of the control). This
increases the resolution. Most
potentiometers will return to a neutral
position when you doubleclick on them
with the left mouse button.

On/Off button
Basic (LS
Text
] Tex

| certer
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Faders are also adjusted with the left
mouse button. With a fader, vertical
motion adjusts the position. As with the
potentiometers, moving the mouse
pointer off and away from the fader will
increase the resolution of the
adjustment.

Text based faders can also be adjusted
by using the mouse. Click on the text
field and move the mouse up or down.

On/ Off Buttons respond to a mouse
click to change their state. Some buttons
have more than two different states.
Often the state is indicated by a certain
color.

Rocker switches respond to a held
mouse button or a click.

If a controller has an accompanying
value field , then you have the option of
entering a value directly into the field.
Simply click in the field - the existing
value will be highlighted and a text edit
symbol appears. Enter the value using
the computer’s keyboard and confirm it
by pressing the <Enter> key or clicking
anywhere on the surface outside the
number field.

Several controls can be manipulated with
the computer keyboard. For a list of these
assignments, see the Appendix.



Context menu of modules

From every module in the Project
Window you have access to a context
menu which contains nearly always the
same dialog boxes. It can be opened by
right clicking on the module name. The
context menu is, like many other context
menus, splitted in two sections as you
can see on the screen shot. The first
section refers to the module itself
whereas the other section is part of all
context menus in this window.

Save as new module: Gives the option
to save the module in a new file.

Remove module: Another option to
delete a module is to click on this text
field.

Edit nfo: This dialog box opens an editor

.
Gain

pin B 1 out

Save a3z neswy Module
Femowve Module

Edit nfo

Attributes

Feload DSP fie
Feload all DSP files
D=

Surfaces

Open hodule List
Clozse Projectindow
Cloze FileBroweser
Cloze ToolBar

Cloze ProjectExplarer
Open Padlist

Open Gos

Cpen ModuleParameterList
Open ModuleParameterTree
Open PresetParameterList
Open Uniguell Editor

where you can write new nfo files for
modules. These will appear in the tool
tips and in Help Window if you hold the
mouse cursor over the module. For
more information about nfo-files have a
look at the , Edit nfo* tutorial.

Attributes: This dialog opens a window
which contains all the attributes of a
module. You can change the attributes
by selecting a value and press F2 on
your keyboard. After typing in the desired
new value press Enter.
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| M ame b 1
Class Fepdtom

File D0 A LastSCOPE /D 2p/B azsick oduleLib/Signalddders/Mis /M 11 .DSP

SingleLoad  no
Yoices -1
YVoiceldffzet <ot seb:
BoardlD £not zet
ok zet:

DSPld
OnSameDSP  <not zet:
Hint nes
D5PPlacemen [0,1)
SlotlD £not et

Name:
Shows the name of the selected module
which cannot be changed in this window.

Class:

There are two different classes of
modules DSP modules and Script
modules. DSP modules display as
‘PepAtom’, Script modules take the name
of the Script class.

File:

This attribute indicates the path of loaded
DSP modules. If a DSP module is not
loaded, nothing is displayed here.

In case the selected module is a Script
module, the name of the module without
the file extension is indicated.

SingleLoad:

The polyphonic branch of a synthesizer
,Subject to the adjusted polyphony
(Voices), loads several times on the
DSP Hardware. In certain cases it is
reasonable to load parts of the
polyphonic branch only one time ( i.e.
LFOs).

To enable or diable Single Load select it
and press F2 on your keyboard. Type in
yes to enable or no to disable it. Press
Enter to confirm your change.

If SingleLoad for the LFO is enabled ,this
module exists once only independent
from the number of voices. All the same
it is connected to all voices.

If SingleLoad is disabled and setto ‘No’,
the module would load several times and
cause different beats for every voice.

Voices:

Here you can adjust the polyphony of a
syntheziser.‘<not set>" or -1’ signify, that
the module adopts the properties of the
Parent. If you set Voices to ‘0’, the DSP
module gets deactivated and leaves the
DSP.The other adjustments provide, that
the DSP module loads several times,
corresponding to the appointed Voices.

Board ID:

If the BoardID is set to ‘<not set>’ it takes
over the adjustments of its Parent. If you
want the module to be present on a
specific board you can set the BoardID
to ‘0’ in order to put the module on your
first board. For the other boards type in
the corresponding number like ‘1’ for the
second board, ‘2’ for the third board etc.

DSP ID:
Here you can choose the DSP on which
you want your module to be present.
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On same DSP:

If this attribute is enabled ‘<set>’, the
module and its children are situated on
the same DSP. You cannot choose the
DSP on which the module and its
children will be placed.

Hint:

This attribute is similar to the funktion
of On same DSP. You should use Hint
for Devices. The algorythm tries to hold
them togehter, either on a DSP or on a
board.

DSP Placement:
Here you can see where the selected
module is loaded.

Reload DSP file:

If you changed the code of a DSP File
you do not have to save and restart
SCOPE because you can use this dialog
to reload the selected DSP file without
leaving the project.

Reload all DSP files: If you changed
more than one DSP file you can use this
dialog to reload all DSP files. This is
easier and faster than saving and
restarting the project.

IDs->Write child ID log
-> Write unique ID log
-> Read unique IDs from log

->Set ID compare module

Surfaces: Used to open or close the
surface of the module.

The second section of all context menus
in this window provides a quick access
to the main tools and windows of SCOPE
(Project Window, File Browser, Tool Bar,
Project Explorer, Pad List, GOs, Modu-
le Parameter List, Module Parameter
Tree, Preset Parameter List, Unique ID
Editor)
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Context menu of a Pad

In the first part of a Pad’s context menu
which is also accessible by right clicking
we can find the options Export Pad,

Delete exported Pad, Store Pad and
Edit nfo.

Store/ Connect/Export Pad:

If you wantto connect a Padto a module
at a different level you first have to ‘store’
it and then connect it to the other Pad.
Use the Store button to store a Pad, and
the Connect button to connect it. The
Connect key will be enabled only when
a Pad has been stored. Each Pad can
thus be connected to another Pad
anywhere within a project (assuming
they are compatible).

To use a Pad at the next higher level in
the tree, select it and click on the Ex-
port button. A grey arrow appears, and
a copy of the Pad is created in the
module’s parent module. The exported
Pad s directly connected to the original
one.

Delete exported Pad: Sets exported
Pads back to their old adjustment.

The second part in the context menu of
a Padis the same like the in the context
menu of a module, it gives quick access
to the most important tools and windows
in SCOPE.

Export Pad
Delete exported Pad
Store Pad

Edit nfo

Open Module List

Cloze Projectindowsy
Cloze FileBrowzer

Close ToolBar

Cloze ProjectExplorer
Open PadList

DOpen GOz

Open ModuleParameterList
Open ModuleParameterTree
Open PrezetParameterList
Open UniguelD Editor



File Browser

View Filter Path

Up Cut

Small Icons

Projects Volumes

New Copy

| Large Icons

Favorites |

Devices

Paste

Thumbnails

Delete

Modules and Devices in

the File Browser
Modules are represented in the File

Browserby the symbol @8 , whereas

devices are represented by 188 .

Although not shown in the File Browser,
modules are designated with the *.mdl
filename extension, while devices have
a *.dev extension. Devices are usually
more complex than modules. Examples
of typical devices are synthesizers,
samplers, and mixers.However,
modules, too, can have control surfaces,
and be arbitrarily complex. Modular
Synth patches, for example, are
modules. The essential difference
between modules and devices lies in the
fact that modules are saved as
components of the project, while devices
are saved as references. Therefore a
project contains all its modules, plus
references to devices which are loaded

Modules

Presets

STS-Samples
STS-Programs

Colors

Textures

Gradients

All Files

from their respective directories when
the project loads. This difference would
be negligible to you except for the
following implications:

- Since projects are stored using the
current version of a module, it may be
necessary when updating to a new
version of SCOPE to replace individual
modules stored within a project by their
updated versions. You will be notified in
the README file of a new SCOPE
version if this is necessary.

- When a project loads, it looks for the
path for the devices to load, and if they
are not present, the project cannot be
loaded completely. This means that if you
exchange a project with another user who
uses a different directory structure,
some of the devices may not be found.
In this case the software will ask you
for a path specification to the device
location. If the device does not exist in
the user’s environment, then the project
cannot be loaded completely.
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- Changes made to devices (e.g. device
updates or Preset changes) will affect
all projects that use the device.

As you have seen, the distinction between
Modules and Devices has some relevance
for you as a user.
However, in order to increase the
m readability of the manual we sometimes
interchange the terms which, if not clear
from the context, should be considered
to be equal.

The File Browser is used for:

- loading devices and modules into your
project

- loading samples and sample programs
into an optional sample player

- loading projects (as an alternative to
the Open option in the File menu)

- administrating and organizing your files
(copy, cut, delete, rename etc.)

up navigation
path

folders

drives F modules

favorites

The File List

This File Browser sorts the files
alphabetically, and shows those file and
file types enabled for viewing (see: Fil-
termenu). Select a file by clicking on its
name. To rename a file, click once again
on a selected file to enable edit mode.

Use Drag ‘n’ Drop with the left mouse
button to load a device (mixer inserts,
sample files) into the Project Window.

Navigation

When SCOPE starts, the File Browser’s
path is set to the Circuit design directory.
All drives, directories, and files are
identified by a symbol, and listed as a
text entry (drives and directories in
yellow, files in blue).

To change to another directory you can
click once on its symbol, or double click
on the text entry. By
clicking on the symbol
or by selecting Up from
the Directory menu
you will arrive at the
next higher level of the
directory structure.

Dir |
4] W
,_:ﬂ Mewy

At the highest level the drive designations
will appear instead of directory names.

If you want to create a new directory
you can select New in the Directory (Dir)
menu. The directory is named New Fol-
der by default but it can be renamed at
any time.

Clicking on the current path text, or on
the small arrow symbol, opens a drop-
down list from which you can select a
drive.
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For quick navigation to frequently used
directories you can create a Favorites
list.

This list is located at the bottom of the
File Browser. Add a new entry by
selecting the Favorites menu entry. The
buttons ,+“ and ,-“ are used to add or
remove a directory from the list.

File Operations

The File Browser’s

EE.. menu includes, among
o Cut other things,
=] Copy instrucpions for common
- operations such as cut,
M Paste copy, paste,delete.
' X Delete Those commands are

accessible by clicking
on the Edit menu.

As an alternative to using the menu
system, several common key
combinations have been implemented,
including the <Ctrl> +C/V/X (for copy/
paste/cut) and the <Delete> key. A
complete list of keyboard alternatives is
found in the reference section.

File View
In the View menu you
iew | can select large or
" Small lcons small icons for the list
format, or you can
Large lcons choose to display
Thurmknails minimized versions of

the module surfaces
(thumbnails).

You can use file
filtering, found in

o]

Projects the Filter menu, to
I Ilmlt the file types
displayed to those
[Modules pertinent to the
Presets situation at hand.
LR ARTEES This increases

STS-Programs clarity and ease of

file selection. For

Colors !

: Instance, you can
it limit a listing to
Gradierts show only Sample
All Files files when working

with a sample
player.

If you cannot locate a particular file, or
a directory or CD-ROM seems to be
empty, perhaps filtering is set to display
only a single file type.
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Context menu

Clicking with the right mouse button in
background of the File Browser calls up
a small context menu:

Showe Akai Partitions
Clear CO-Cache

Show AKAI Partitions:  With AKAIformat
CDs, a partition letter is shown in
addition to the file name. This option is
useful when different AKAI partitions
contain files of the same name and must
be differentiated.

Clear CD Cache: If two CDs have the
same serial number, the CD contents is
not refreshed when one CD replaces the
other in a drive. This option clears the
cache, thus forcing a manual directory
refresh.

By right clicking on a symbol or a text
entry almost the same context menu
calls up again. There is just one
diference:

Fename
Showe Akai Paritions

Clear Ch-Cache

Rename: Change the name of the of the
selected file or directory.



Project Explorer

Tool Bar

Alignment Color Gradient Tool Tips
Central Texture Text Highlight
Dimensions Shadow Grid Help Window

When working on the surface design of
your project you should keep the Toolbar
open. The Tool Bar gives you quick
access to all the GO editors.

GOs (Graphical Object) are simple
graphical objects like text, a bitmap, an
animation etc. A GO tree is a
composition of multiple GOs - like most
of the surface elements. A button for
example consists at least of a Back-
ground, a ButtonOn bitmap and a
ButtonOff bitmap. A GO can be changed
with the different tools from the Tool Bar.

Open the Tool Bar from the Window
menu or by pressing F12 on your
keyboard.

Project Explorer: Opens and closes
the Project Explorer dialog - a central
repository for the project’s overall design
and routing information.

Alignment: Opens and closes the
Alignment dialog where you can adjust
an object’s position relative to its parent.

Central: Contains two sections,
Preview and Attributes to adjust the
appearance of GOs or modules.

Dimensions: Opens and closes the
Dimensions dialog in which the position

and size of GOs and modules can be
adjusted.

Color: Opens and closes the Color
Selector in which you select the colors
for dynamic bitmaps, text and gradient
nodes.

Texture: Opens and closes the Texture
dialog in which you select textures for
bitmaps.

Shadow: Opens and closes the Shadow
dialog where you assign shadows to a
objects.

Gradient: Opens and closes the Gradi-
ent used to process color gradients for
dynamic bitmaps and text.

Text: Opens and closes the text editor
for adding or modifying plain text.

Grid: Enables or disables the Grid.

ToolTips: Enables and disables the Tool
Tips feature.

Highlight: Enable this so selected
modules will be visibly highlighted.

Help Window: Opens and closes the
Help Window where information on the
selected module or Pad s displayed.
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Gradient Desinger

_ Blitter
Project  Text Options

Explorer Fill Style

Bitmaps/Animations
Selector

The Tool Bar dialogs

The tools, which will be described in this
chapter, have a common task line. Each
window,except the dimensions and the
text tool, has a small box to enable or
disable the tool.

enable/
disable transfer

copy paste

If you want to transfer the adjustments
you made to another GO you have diffe-
rent possibilities: First you have to copy
the settings by clicking on the copy icon
in the task line. Then you can transfer
these settings to another GO by
activating the transfer
option. To transfer the
to the copy icon; the
arrow will turn red. Now
you can select the GO to which you want

settings only one time,
click on the arrow next
to transfer the settings.

Color Texture Shadow
Options

Alignment ~.. Hel
g Grid Tool Tips Win%ow

Highlight

Transfer Options
Dimensions

If you want to transfer the settings to
more then one GO you
can click on the arrow

" a second time and
three yellow arrows
will appear. Now you
can transfer the

settings to a series of GOs.

If it is difficult to transfer
adjustments to a specific GO because
it is tricky to select it you can use the
Paste function (last icon on the task line)
instead of the transfer arrows. Then you
can select the GO first and paste the
settings when you are sure that you
selected the right GO. Instead of
selecting the GO by clicking onitin the
Project Window you can also reach the
GO through the GO list ( right-click on
the module to get in the context menu:
Open GOs) and select it there.
Alighment

With the functions in this dialog you are
able to specify the alignment of the dif-
ferent GOs. You can type in values in
the text fields that determine how shifted
the GO should be.

Left Offset: Distance of the middle point
of the object to the left edge of the
parent.
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Right Offset: Distance of the middle
point of the object to the right edge of
the parent.

Top Offset: Distance of the middle point
of the object to the top edge of the parent.

Bottom Offset: Distance of the middle
point of the object to the bottom edge of
the parent.

-.E r-.
Right Offse
e v+ NN W

T O
Bottom Offeel

Alighment E3
Left Offset

T o
0 e
Top Offset

Alignto Left: Enable this option to align

the object to the left edge of the

{:. parent at the distance defined
in the Left Offset field.

Align to Right: Enable this option to
align the object to the left edge
L of the parent at the distance
defined in the Right Offset field.

Align to Left and to Right:  Aligning to
both the right and the left edges of an
object by clicking both icons
consecutively would appear to be a pa-
radox. But in SCOPE you have dynamic
objects - dynamic bitmaps and graphical
text. With these objects it is possible to
align not the center point, but their edges
of the respective edges of the parent.
The object will then contract or expand
when its parent is resized.

Align to Middle: Aligns the object

horizontally in the center of the

¢ parent. The L/R offsets have
no effect with this option.

AligntoTop: Enable this option to align
the object to the top edge of the
parent at the distance defined in
Top Offset.

Align to Bottom: Enable this option to

align the object to the top edge

a of the parent at the distance
defined in Bottom Offset .

Align to Top and to Bottom:  Similar to
the ‘Align to Left and Right’. However,
again it is not the center, but the edges
of a dynamic object that are aligned to
the top and bottom edges of the parent.

Align to Center: Aligns the object
vertically in the center of the
.2 parent. The Top/Bottom offsets

= have no effect with this option.

Central

Central E3

This dialog has a lot of different functions.
It is the ‘central’ tool when working with
GOs. You can load and save files by
clicking on the File button. To adjust the
view, click on the View button and
determine between bitmap and bump.
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The rest of the window is divided into
two sections: Preview and Attributes.

The Previewshows the selected module
as a dynamic bitmap.

Dynamic bitmaps are a special kind of
bitmap that can be resized at run-time.
This is important when designing a
surface, and you do not know yet what
size it will be. The supplied default
surfaces were all created as dynamic
bitmaps. SCOPE uses the following
technique to convert a normal bitmap
into a dynamic bitmap:

The bitmap is divided into nine tiles with
two horizontal and two vertical ‘splitter
lines’. If a dynamic bitmap is horizontally
adjusted in Edit mode beyond its origi-
nal size, the upper, and lower middle
tiles, and the central tile, are drawn
repeatedly next to each other as required.
The corners are shifted accordingly.
Vertical sizing is achieved in a similar
way - by drawing the left and right middle
tiles, and the central tile, repeatedly. Both
dimensions can be adjusted at the same
time. Also, if the object has a shadow, it
IS resized, too.

Marmal

Mormal
haLittipaly

Hardlight

Hardlight 9
— DL

Simple

Simple

Bright

- , —
Dimensions g £

postion 1) MEECHN () HEEE

sze OEEE OES
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Color

If you want to change the color of a GO
you need the Color window.

The Color window shows the current
color of the selected panel. In order to
change the color you have to scroll
around the color circle with the pressed
left mouse button, dragging the point with
the mouse.

To get the nuances of the selected color
you can move around in the color box
and click on the right nuance. You can
also click on the text fields of Red, Green
and Blue to change the color. Those text
fields are text based faders. Click on the
and drag the mouse, with the press left
mouse button up or down.

To change the opacity proceed like
before, the text field is a text based fa-
der, too.

Color K4

Texture

In order to use a texture you have to
open the Texture window and enable it
by clicking on the small box next to the
title. The texture of the SCOPE
envirnment gets visible in the box in the
window and on the selected GO. To rotate

the texture click on the knob in the circle
keep it pressed and drag itaround. T o
enable the zoom just click on the text
field with the left mouse button pressed
and drag it up.

Texture B3

Shadow

In this dialog you can adjust the settings
of the shadow of the selected GO. With
the Feather fader you determine wether
the shadow is chiseled or blurred.

All text fields which display the current
value can also be used as text based
fader.

Offset X describes the horizontal
orientation and Offset Y describes the
vertikal orientation of the shadow.

With the last fader you can adjust the
opacity of the shadow.

Shadow Ei
Feather .

Dffset X

Offset ¥
Opacity ~ -
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Gradient H

o e
’/"F' Angle

Type &

Gradient

The Gradient unifies the Texture and the
Color tool. To activate the Gradient you
have to click on the small box next to
the title. The selected Go wil get a black
and white gradient. There are three dif-
ferent types and two orders of gradients.
You can change the color with the color
selector as already described. In the
texture box the gradient type is visible.
Another function you can activate is
loops. The text field is again a text based
fader; so click on it, keep the mouse
button pressed and drag the mouse up.
The amount of loops will raise until
twenty.

align centered

Order @ @)

£y

Loops

Invert W

Resuli

Red

Green

opacity  Blue

Text

With this tool you can change the texts,
for example, if you want to rename a
module.

SCOPE uses two kinds of text - Stan-
dard Text and Graphical Text. These differ
as follows:

Standard Text: This refers to normal,
Windows text. This is used for text that
can change at run time, such as in a
control’s text field. All controls and
modules that use standard text default
to the Arial font, since at the time of
writing it is installed on all PCs running

type size align bottom typeface

- =
l::i'

Pulzar? [0] ADAT A Source  \ (14 |\ Atial

Text Additional
name A A A I =
italic
bold underlined align
align left right

= [A [a] a] ¢ P
block align align muli line auto size
top  middle on/off on/off
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Windows. If the font is not available,
another will be substituted. Standard text
IS not anti-aliased, so it is not really
appropriate for static text used for labels
or design elements.

Graphical Text: Always use this text
when its appearance is important, such
as in controller names on synth surfaces
or other labels that will not change at
run time. Graphical text uses the same
fonts as standard text, but it is anti-
aliased (the edges are smoothed) and
rendered immediately into a bitmap. The
font used to render the graphical text
does not have to be installed on the
computer on which you want to use the
object. However, the link between the
font and the bitmap is preserved so the
text can be modified at any time by
adjusting parameters such as rotation
and scaling. After each change, a new
bitmap is produced.

If you produced some graphical text
using, for example, the Avalon font, and
then removed the font from your system,
the graphical text would still be displayed
in the Avalon font. If you then try to
modify the graphical textin SCOPE, you
will not be able to, since the Avalon font
IS no longer available. In this case, the
next available font is substituted.

Options (for standard text only)

The options for standard text are found
right under the line where the name of
the selected module, the type size and
the typeface is displayed.

In order to change the size click on the
size value, keep the mouse button
pressed and drag up and down. To
change the typeface click on the small
arrow next to the typeface name. A drop

down menu opens and you can choose
a new typeface. The three ‘A’ icons are
symbols for Bold , Italic and Underlined .

Align Left: The textis aligned to the left
side of the text block.

Align Right: The text is aligned to the
right side of the block.

Align Centered: The textis centeredin
the block.

Block: The text is justified (each line
adjusted to fill the block).

AlignTop: The textis aligned to the upper
edge of the block.

Align Middle: The text appears in the
middle of the block.

Align Bottom: The textis aligned to the
bottom edge of the block.

Multi Line: Enable this option to enter
more than one line of text. If the text
block is smaller than the text, the text is
clipped (only partly visible).

Auto Size: The text will be automatically
sized to fit a block. A line break can be
forced by including the tilde (~)
character.

Additional:
Transform (graphical text only)

Modifications to graphical text beyond
font selection and size can be made by
changing from Text mode to Additional
mode. Therefore you have to click on
Additional next to the Text title in the
window.
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horizontal scale

Text Additional

tracking

E"-

E_
E_.

| %

vertical scale

Horizontal Scale: This adjusts the
aspect ratio of the text on the horizontal
axis (stretching, compressing).

Vertical Scale: This adjusts the aspect
ratio as above, but on the vertical axis.

Rotation: Text can be rotated between
0° and 360°.

Tracking: Increases or decreases the
amount of space between letters,
adjusting the length of the text without
changing the aspect ratio of the letters.

Tool Tips: Several of the buttons and
controllers in SCOPE will display tool
tips, small, concise reference boxes, if
the mouse is held over the object
temporarily. Tool tips are
displayed only if they are
activated via the icon on
theTool Bar. They imply
helpful information of the
different Pads on a module. They will
either display the Long name of a Pad or
its value. The tool tips also provide
information about the icons on the Tool
Bar and the controllers on a surface.

Attack Time 3.750 meec

I

AHb e

b ——

+ I

rotation

Highlight : To enable or disable this option
click on on the light bulb icon on the
Tool Bar. If you select a module in the
Project Window it will become highlighted
in the Project Window and in the module
tree in the Project Explorer.

G . . R . . .
Thil The2 Lhd & O 5 =

ot
inw

bGate NEW device

i ASI0 Dest
ADSH Pitch EG

new device
Input Gain

Help Window : This option can also be
accessed via the Tool Bar, just
click on the question mark (or

- press F1 on your
keyboard).The new window
that pops up will offer

information about a module or a Pad if

you hold the mouse cursor over it.

Furthermore it displays the name of the

module in the first text field. In the line

below you can see if the selected object
is a module or a Pad.
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Module Description :If the selected freeze button
object is a module you get information
about the location where the process is
running (DSP or PC) and whether it loads Help Window
one time (monophonic) or several times =

(polyphonic).

Help Window

module
name

module
description

Sometimes it can be useful to freeze the
settings that are currently displayed in
the Help Window. Therefore you can
click on the stop sign in the right upper
corner of the Help Window.

detailed information

Pad Description :If the selected object
is a Pad you will get information about
the typ of the Pad and whether it is bipo-
lar or unipolar.

The main information is displayed in the
area underneath those descriptions.
Here you get a detailed explanation of
the module and for which construction it
is best applicable.

If a Pad has a range it will be displayed
in the Help Window as well as a
proposition to which Pads it can be
connected.
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Project Explorer

Pad | Pad I

| Attributes |

Connections

| Routings |

I Freeze I

| vars |

| Store |

| connect |

| Export |

The Project Explorer

This tool is the central resource for the
examination and modification of module
circuits, devices and surfaces.

It's deceptively simple-looking when first
opened. However, it contains many
drawers which display exhaustively
complete information about the structure
of a device — its internal hierarchy, the
modules it contains, their connections
and so on. As arule, these displays are
interactive — you can modify virtually
any aspect of a device or circuit via one
or another section of this tool.

The following paragraphs describe the
Project Explorer dialog and the various
context menus available.

The current Projectincludes all modules
and their connections. In this view,
however, no connections are displayed
- only the modules themselves.

GO Freeze

Connections

| View 1D |

| View Layer |

| Addco |

| Freeze |

If a module contains other modules, it is
marked with a ‘+’ symbol:

By clicking on the ‘+’ symbol, or double
clicking on a module’s name, the child
modules are made visible below it in a
new branch. Within a branch you may be
able to open additional branches - as
many as required. If a module is

protected ( & ) you can not open it

to view the children.
Context menu of a module

You can call up a context menu for a
module by right clicking on the module’s
name. Select the desired action with the
left mouse button. Some of the dialogs
are the same as the dialogs in the context
menu of a module in the Project Window.
Keyboard shortcuts are available and
listed later.
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Copy
Cut

Delete

Fename

=ave as ..

Loadd b
Exiit 4
Edit nfo

Attribtes

=ave as reference ...
PackDevice ]
Tools ]

Cut, Copy, Delete, Rename, Save as,
Load: These are the regular options to
edit files.

Edit: Gives you access to the scripts
(e.g. Pep/Display/Object) if you want to
edita module.

Edit nfo: This dialog box opens an editor
where you can write new nfo files for
modules. These will appear in the tool
tips and in Help Window if you hold the
mouse cursor over the module. For
more information have alook at the ,Edit
nfo* tutorial.

Attributes: This dialog opens a window
which contains all the attributes of a
module. You can change the attributes
by selecting the desired value and press
F2 on your keyboard. For a detailed At-
tributes discription have a look at page
18.

Save as reference: Stores areference
to a module. Now, when the project is
saved, the module itself is not - only it's
name and where it was located is saved
with the project. Referenced modules are
indicated with a diskette symbol.

PackDevice P | optimize (xto-compatible)

Protect
Delete old circuit GOs

From the Pack devices dialog you can
optimise a module to make it xtc
compatible. Here you have also the
possibility to protect a certain
module.Like the other protected modules
it will be displayed with a lock in front of
the name in the Project Explorer.

ﬁ&uﬁﬁgiiﬁkvﬂr

|8 MewProject
B " ordClockPipe
ﬁ Fulzars [0] MIDI & Source
ﬁ Pulzarz [0] MIDI & Dest
m Sequencer Midi Source 1
i Sequencer Midi Dest 1
ﬁ FPulzars [0] &nalog Source
w Pulzar? [0] Analog Dest
ﬁ Fulzars [0] 5P-DIF Source
ﬁ Pulzarz [0] SP-DIF Dest
e ave Source 1
g ave Dest 1
w2510 Source
g ASI0 Dest
B HF 4pole Retio
B LongZlongSyncdtom
& Fanel
B Text "Panel"
B Eack Frame
B FarentTopChanger
CloseGroup
Contrals Graup
Contralz Group
Contrals Graup
Contrals Graup
B Surfacelnterface

| @Cloze Suface
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Toaols

variable

P | Creste circuit representation
Swap YiewlD Circut -= Surface
Swap YiewlD Surface -= Circuit
Check Performance

Delete all unrouted Pads
SoftProtectar

The last dialog box in this menu is the
Tools dialog. Like the Pack devices
dialog it is useful for the last adjustments
of a module or a device. For example if
you want to fix up your project and you
have a lot of unconnected and
unnecessary Padsyou can select Delete
all unrouted Pads. Your project now
demands less disk space and less
memory consumption and you have
shorter loading times.

Pad |

variable

W al 1082196483
1]
[nkerzity 100

kit

el

[ et
Step
Dizabled
Chrltr
todH ange
BroadCast
Str

Format
tinControl
bl axContro
ztrhdin
zhrhd &
strbdid
Offzet
Driwizor

a
127
o

1000

o

B4

1

o
2147483647

name of the
module

If you click on one of the two Pads buttons
(Pad I, Pad Il) you will find a new window
wil open and give an overview of the
Pads belonging to the currently selected
module. From here you can use the
buttons on top of the window to modify
the values and appearances of the
individual Pads.

A Pad could be considered as a
connection point of the module. It can
be connected to other Pads. Variables
cannot be connected to other variables
or Pads. They can only be edited in the
Variable list . You can transform each
variable to a Pad (from the context menu
of a variable) or transform a Pad to a
variable by deleting it from the Pad List.
A Pad demands more resources than a
variable.

 Var Aftributes
I
InFad

Integer
4

2147483648
2147483647
=

By clicking on the Attributes button a
new window opens and indicates the
Attributes from Vars which have Pads.

Connecfions

j Routings | Synapse
B Input Detector In
= out
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The Connections key gives you access
to the Routings drawer which shows all
direct routings between the Pads as well
as the hierachies. The other function in
this window is the Synapse button which
gives you a list of all connected Pads
without considering any hierarchies.

The next button in the Pad | window is
the Freeze button. As the name pretends,
you can ‘freeze’ the module tree which
Is displayed at this moment so that this
can not be changed. Of course you have
access to the other windows if you want
to alter Pads, have a look at the
connections etc. The Vars function does
not open a new window but notifies the
Vars in the Pad window. The actual
values of all Vars ors Pads are still
refreshed.

When you select a new module, the first
Pad in the Pad Listis also selected. If
you then want to connect a Pad to a
module at a different level you must first
‘store’ it and then connect it to the other
pad. Use the Store buttonto store a Pad,
and the Connect button to connect it.
The Connect key will be enabled only
when a Pad has been stored. Each Pad
can thus be connected to another Pad
anywhere within a project (assuming
they are compatible).

To use a Pad at the next higher level in
the tree, select it and click on the Ex-
port button. A grey arrow appears, and
a copy of the pad is created in the
module’s parent module. The exported
Pad is directly connected to the original
one.

By clicking again on the Export button,

the copy is removed from the parent
module.

Often it makes sense to change the
graphical representation of the Pad’s
type (In, Out or I/O). This would be the
case, for example, if you export an In
Pad which is connected to an Out Pad.
You can change the appearance of a Pad
using the keyboard keys <I>, <O> and
<P>, or by selecting Type from the
context menu (right clicking on the Pad
name in the Pad List).

Context menu of a Pad

=tore

Connect to 3
Export

Default Layout
gy b
Type b
Qrrientation 2

Restore Level P
hodular Class p

This context menu has some more
options to arrange the settings of Pads.

With the first command in the context
menu we can ‘Store’ the Pad settings.
Scope will then memorize that we want
to connect this Pad. If we click on
‘Connect to’ it will automatically suggest
the possible connections.

We can use the ‘Export’ dialog box if we
want to transfer a Pad into another layer.
To reset the settings we can use the
option ‘Default : Layout’. With the next
commands we can change the Padsthe
way that they suit to our needs.

We have three options to change the
view of the Pad names. Normally the
Pads in the Pad Listare written in short
names. In order to get the full name of a
Pad we can change this setting by
clicking on Long Names .

45



Clicking again on this dialog box will set
this option back to Short Names .

YWigy P | Long Names
Type P | Enable Hexiew
Criertation B | Hide hidden pads
Restare Level b

Sometimes it is useful to get another
representation of the values. Therefore
you have the option to change enable or
disable the Hex View ( hexadecimal).

If a Padis hidden on a module it is still
visible in the Pad List. In order to change
this you can activate Hide hidden Pads ,
then all hidden Pads on the module will
also be hidden in the Pad List.

If you have to change the type (I/O Pad,
input Pad or output Pad) of a Pad, we
can also do this through the context
menu.

Type P | 1oPad
Crientation P | inPad
4

Festore Lewvel OutPad

While changing the type in the dialog
box,the actual Pads on the module
change their appearance.

Sometimes it is useful to change the
orientation of a Pad to keep track of the
circuit.Therefore the Pads can be
positioned on every side of the module
or become hidden if they are not needed.

Orientation B | Left

Restore Level B | Top

Modular Class B | Right
Bottom
Hide

To change the orientation you have to
open the menu from the ‘Orientation’
dialog box in the context menu and
choose the Pad position you need.

The Restore Level gives the
possibilities to decide, whether a Pad
should be restored in Preset or not. For
devices it is helpful to enable don’t
restore after loading.

Restare Level b
hWodular Class P

Festore in Preset
Con't restore in Preset
Dont restare after loading

The arrangements that are described
here for the Pad | window are exactly
the same for Pad Il window.

Graphical Objects

Graphical Objects I
Add GO |F

Dietault

Input Detector

The next button on the Project Explorer
is the GO key. If you click on it a new
window comes up. The sequence of GOs
in the tree, and whether they are parents
or children, determine the way in which
they are drawn.

1. Children are drawn over their parents.
2. GOs at the same level are drawn in
the order in which they appear in the
list.
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Context menu in the GO window

Rightclicking on the name of a GO opens
a context menu. The first commands

Cut

Copy

Delete

Fename

Export a= Bitmap ...
Export a= Screenshot L.

(Cut, Copy, Delete, Rename) should be
familiar to you. Sometimes it can be
useful to export a GO as a bitmap or as
a screenshot. Then you can use these
two dialog boxes; they will bring you in
the ‘Save’ mode where you can easiliy
save a GO.

Attributes

z-order information
value field

GOAfributes -
| C circuit) [(Normal el EERIE
X Visible -
¥ Selectable
DisplaySelection
Fixed Z-COrder

view ID

Messading
Draw ClipChildren
Select ClipChildren

In the Attributes drawer you can adjust
properties to further control the way in
which objects are drawn.

Visible : Controls the ViewlID and
therefore the visibility of the selected
GO/GOTree depending on the view
context.

Selectable, if enabled, means that the
object can be selected by the user with
the mouse. In Edit mode it will be
selectable regardless of this setting.

Fixed Z-Order: This flag forces all GOs
into a fixed hierarchy. The top level
hierarchy is determined by the hierarchy
of the Project Explorer followed by the
hierarchy determined in the GOTree. The
GOTree is a composition of simple GOs
as shown in the GO Window. Generally
speaking this flag affects GOs that are
located on the same level in the GOTree
as well as GoTrees on the same level in
the Project Explorer.

Messaging must be set in order for the
object to respond to user input (mouse
clicks on the object, etc).

Draw ClipChildren: For performance
issues the ‘Draw ClipChildren’ flag should
be always set (with exception for the
‘close group’). This flag effects groups
of surface elements (a number of sliders
and their names, etc.) and forces the
group to only draw/redraw GOs that are
inside the group’s borders. Everything
outside the group is clipped. If this flag
IS not set the group looks for its elements
on the whole surface to (re)draw them.
This could be time consuming.
If you use your own graphical objects
you should give the object the appropriate
dimensions when creating them. That
way a group that holds these elements
will automatically be adjusted to the right
size. Otherwise it might be necessary
to resize the group manually in Edit
mode. In former versions we advised to
calculate the shadows into the GOs.
Because we have improved the algorithm
and integrated shadows this can cause
problems with the ‘Draw ClipChildren’
attribute. It is no longer preferable to do
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so. The overhead for dynamic shadows
has been greatly reduced and we
recommend using them.

Select ClipChildren: Maybe you decide
to not set the ‘Draw ClipChildren’ flag
because you have some GOs that you
have positioned outside the group and
you want them to be displayed. In such
cases you might want to use the ‘Select
ClipChildren’. This flag prevents these
elements from being selected, and thus
the group does not need to check inputs
from them.

On top of the window there are two text-
based fader and an information field.

ViewlD:

Lets you adjust the ViewlD of the
selected module. Elements with their
ViewlD set to ‘Surface’ are only visible
in ‘surface view ’, ViewlD ‘Circuit’is only
visible in‘circuit view ’and ‘None’ is not
visible at all.

Z-Order value: (works in conjunction
with the ‘On Top’ flag)

To design sophisticated interfaces for
your devices Scope allows you to place
different GOTrees on top of each other.
This order is the so-called Z-Depth or
Z-Order. With this value you may adjust
the Z-position of the element. A GOTree
with a higher value is positioned on top
of these with lower values.

Information Field: Tells you which GO-
type is currently selected.

Text
® Standard Text
# Graphical Test
# Bitmap
® Border
# Dunamic Bitmap
# Animation
® View

® Screen

# Group

# ScrollGroup
# Device Context

# [cScreen

Add GO

You can drag and drop GOs from the
Add GO drawer into the GO tree or into
other objects.

When you drag and drop a GO to an
object in the GO tree it normally
becomes a child to that object. If you
press the shift key just before dropping,
however, it will become a sibling to the
object. You can, for example, add addi-
tional text (standard or graphical text)
or another bitmap to a graphical object.
More information on GO types can be
found in the Surface Design section.

In the Add Go window, as well as in the
Project Explorer itself, you have also the
possibility to ‘freeze’ the illustration you
have in order to vary something without
changing the adjustment in the window.
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Browser 4
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circuit view 48
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Clear CD Cache 32
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Connected 9

Connection is separated 21
Connection not possible 21
Context menu 32

Context menu in the GO window 47
Context menu of a module 42
Context menu of a Pad 28, 45
Context menu of modules 25
Control elements 23

Control Ranger 5, 7
Controller 5

Copy 43

Create new icon on minimize 8
Ctrl Assignment 7

Ctrl List 6
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curser 21

Cut 43

D

Delete 43

Delete exported Pad 28
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Deleting modules and devices 20
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Draw ClipChildren 47

DSP ID 26

DSP Load 5, 6
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Dual Screen 7

E

Edit 43

Edit Mode 17

Edit nfo 25, 28, 43
Enter 15

environment 4
Exchanger 5, 11
Exit Scope 5
Explorer 4
Export 28, 45

F

Fade windows 8
Faders 24

File 5, 26

File Browser 4, 12
File Directories 8
File List 30

File Operations 31
File View 31

Fixed Z-Order 47

G

GO 48

GO window 47
Gradient 33, 38
Graphical Objects 46
Graphical Text 39
Grid 8, 33
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Hex View 46 _

Hide hidden Pads :-) 46 Pack devices 43
High quality icon 8 Pad Description 41
Hlghlight 40 Parameter Ranger 14
Highlight 33 Parameter Tree 14
Hint 27 Parameters 13

plug symbol 22
polyphonic 41

| potentiometers 23
Preset Parameters 14
Preview 36

Horizontal Scale 40

Information Field 48

:Patﬁ(r:fa;; 4 Project as Default 8
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L Project Explorer 4, 12, 33, 42
Project Settings 20

Learn 7 Project Window 4, 16

Left Offset 34
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Load 43 R

Loading modules and devices 20 Registry 5, 10
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9 Reload DSP file 27

pull-down menu 5

M Remove module 25
Rename 32, 43

Master 9 Reset 6

Menu bar 4 Restore Level 46

Messaging 47 Right Offset 35

MIDI Controller Assignment 6 Rocker switches 24

Module Description 41 Rotary Contols 23

Module Exchanger 11 Rotation 40

Module Parameter Tree 14

Module Parameters 13 S

Modules 29 S/P -DIE 9
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MoUSe cursor 21 Sample Rate Settings 9
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Offset 37 Show windows while move 7
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Standard Text 38
Store 28, 45
surface view 48
Surfaces 23, 27
Synapse 45
Sync Source 9
System 9

T

Text 33, 38

Text based faders 24
Texture 33, 37
Tool Bar 4

Tool Bar dialogs 34
Tool Tips 33, 40
Tools 44

Top Offset 35
Tracking 40
Transform 39

Tree 14

Type 45

U

ULLI Settings 5, 10
Underlined 39
Unfold 18

Use Mode 17

User Interface 4

Vv

Variable list 44
Vertical Scale 40
View 5, 31
View Menu 6
ViewlD 48
Views 19
Visible 47
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w

Wave source/dest 20
Window 12
Work modes 17

Z
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